Module 3: THE INTERNET

1. Introduction

Technology in today’s world plays a big role in many peoples lives in the high tech world we live in today. Making lives easier and more convenient, high technologic inventions are created or invented to better peoples lives. High tech researchers are always finding ways to improve daily activities and inventions that were already improved. Computer has changed ways people work, do business, problem solving, research, ways of communication, and the variety of choices people have to find entertainment. Its hard to imagine how the world would be if computers didn’t exist. Computers have a tremendous impact on society and will continue to find ways to improve and better people’s lives.

• Electronic computers have been around for over a half a century. In the past, computers were almost only used for military, scientific, and technical purposes. Only a handful of scientist and technicians were the only ones able to use the computer. Computers were used to figure out complex calculations and that were very time consuming for human calculation. Over the years, computers have become more and more of an essential tool in all types of businesses and households around the world. With tools such as the Internet, computers have virtually become disposable.

• Over the past few years, computers have become a vastly popular household item. The luxury of emailing messages as opposed to charging up the phone bill is more appealing. Checking news, weather, and sports via the Internet is a convenience that many are taking advantage of.

• Our children’s lives are already getting influenced by technology – and this is just the beginning. Computers and Internet are here to stay and software titles targeting young children continue to increase. Computer science has become a compulsory subject in our schools. Today, We find computers in use everywhere, whether we go to reserve an airline ticket or to a Bank. This is because it is faster and helps us complete our work without mistakes/errors. So Parents and teachers too have realized the need to help their children develop strong computer skills.

By the end of this module, audience should be able to:

1. Describe how internet works and its major capabilities
2. Identify the benefits the internet offers learners and business organizations.
3. Demonstrate how internet can be used for various purposes.
4. Examine the challenges posed by the internet to business and society

2. Computer Basics
**What is a Computer?** A Computer is an electronic device, operating under the control of instructions stored in its own memory unit, that can accept data (input), manipulate the data according to specified rules (process), produce information (output) from the processing and store the results for future use.

![Figure 1: A Personal Computer](image)

**What does a computer do?** Whether small or large, computers can perform four general operations. These operations comprise the information processing cycle and are input, process, output, and storage. Collectively, these operations describe the procedures a computer performs to process data into information and store it for future use.

**Why is a computer so powerful?** A Computer derives its power from its capability to perform the information processing cycle with amazing speed, reliability (low failure rate), and accuracy; its capacity to store large amounts of data and information, and its ability to communicate with other computers.

**How does a computer know what to do?** For a computer to perform operations, it must be given a detailed set of instructions that tells it exactly what to do. These instructions are called a computer program, or software. Before processing for a specific job begins, the computer program corresponding to that job is stored in the computer. Once the program is stored, the computer can begin to operate by executing the program’s first instruction after another until the job is complete.

**What are the components of a Computer?** To understand how computers process data into information, you need to examine the primary components of the computer. The five primary components of a computer are input devices, and central processing unit (control unit and arithmetic / logic unit), memory, output devices, and storage devices.

![Figure 2: Printer (output device) and Diskette (storage medium)](image)
3. Internet Basics

Learn about the Internet, the worldwide computer network that allows people to communicate and exchange information. This module provides a basic understanding of the Internet and World Wide Web. Topics include modems, web browsers (Internet Explorer), Internet Service Providers, and surfing strategies.

A Brief History of the Internet

In 1969, the US Department of Defense started a project to allow researchers and military personnel to communicate with each other in an emergency. The project was called ARPAnet and it is the foundation of the Internet.

Throughout the 1970's, what would later become the Internet was developed. While mostly military personnel and scientists used it in its early days, the advent of the World Wide Web in the early 1990's changed all that.

Today, the Internet is not owned or operated by any one entity. This worldwide computer network allows people to communicate and exchange information in new ways.

According to www.commerce.net, in April of 1999, there were 92.2 million Internet users over the age of 16 in the United States and Canada.

What is the Internet?

The Internet is the largest computer network in the world, connecting millions of computers. It really stands for International Network of Computers. A network is a group of two or more computer systems linked together.

There are two types of computer networks:

i.) Local Area Network (LAN): A LAN is two or more connected computers sharing certain resources in a relatively small geographic location (the same building, for example).
ii.) Wide Area Network (WAN): A WAN typically consists of 2 or more LANs. The computers are farther apart and are linked by telephone lines, dedicated telephone lines, or radio waves. The Internet is the largest Wide Area Network (WAN) in existence.

Servers

All computers on the Internet (a wide area network, or WAN) can be lumped into two groups: servers and clients. In a network, clients and servers communicate with one another.

A server is the common source that:

Provides shared services (for example, network security measures) with other machines and manages resources (for example, one printer many people use) in a network.

The term server is often used to describe the hardware (computer), but the term also refers to the software (application) running on the computer. Many servers are dedicated, meaning they only perform specific tasks.

For example,

- An email server is a computer that has software running on it allowing it to "serve" email-related services.
- A web server has software running on it that allows it to "serve" web-related services.

**Clients**
Remember, all **computers on the Internet** (a wide area network, or WAN) can be lumped into two groups: **servers** and **clients**, which communicate with one another.

**Independent computers connected to a server** are called **clients**. Most likely, your home or office computer does not provide services to other computers. Therefore, it is a **client**.

Clients run **multiple client software applications** that perform **specific functions**.

For example,
- An email application such as Microsoft Outlook is client software.
- Your web browser (such as Internet Explorer or Netscape) is client software.

**Servers and Clients Communicate**

- Your computer (client hardware) is running a web browser such as Internet Explorer (client software).
- When you want to surf the web, your browser connects to a remote server and requests a web page.
- The remote server (server hardware) runs web server software (server software).
- The web server sends the web page to your computer's web browser.
- Your web browser displays the page.

**The World Wide Web (WWW)**
As you now know, the **Internet** is the physical computer network (computer, monitor, modem, cables, phone lines, etc).
So, what is the World Wide Web?

- The Web is a system of **Internet servers** that support **specially-formatted documents**.
  - These specially formatted documents are **text documents** created in **HTML**, a formatting language. In conjunction with the **World Wide Web**, your **web browser** interprets these text documents so they become **web pages**.
  - **Web pages** contain formatted text, graphics, sound, animation, and video, allowing point and click navigation.

Before the Web, the Internet was mostly text-based. To use it, you had to know lots of keyboard command prompts, making it largely unusable to the average person. The World Wide Web changed all that.

**Some Important Web Terms:**

**WWW**

Also called the Web or World Wide Web.

**Web Browser**

A piece of software used to navigate the Web. Internet Explorer and Netscape are web browsers.

**GUI (Graphical User Interface)**

A GUI (pronounced GOO-ee) takes advantage of your computer's graphics (picture) capabilities to increase ease of use. For example, the buttons you point and click to surf the web is part of your web browser's GUI. Most operating systems include a GUI, such as Windows and Mac OS. In the past, there was no pointing and clicking; rather, the user had to know a command language to operate the computer.

**HTML (Hypertext Markup Language)**

The formatting language used to create web documents.

**Hypertext**

The system of electronically linking words or pictures to other words or pictures.

**URL (Uniform Resource Locator)**
Each web page has its own address on the Internet, which is called a URL. To recognize one another over the Internet, computers convert human-friendly addresses like www.gcflearnfree.org to numerical IP addresses. You may type in either 216.119.102.26 (GCF Global Learning’s IP address)

**HTTP (Hypertext Transfer Protocol)**

You may have noticed the http:// preceding URLs. For example: http://www.gcflearnfree.org. The first part of the URL, usually HTTP, indicates the file type. HTTP, the system for transferring web documents, defines how messages are formatted and transmitted over the Internet.

Today, many people use the terms Internet and World Wide Web interchangeably. For example, "I need to get on the Web." Or, "I need to get on the Internet."

**Connecting to the Internet**

To connect to the Internet, your computer requires a **modem** and a **web browser**.

**What is a modem?**

- A **modem** is a device that **converts** a computer's **outgoing data** to a format that can be transferred via telephone lines. Modems can also convert **incoming data** so the computer can read it.
- A modem can be located inside or outside your computer. Some of the different types of modems are internal, external, voice/data, and fax modems.

**What is a web browser?** Remember, along with a computer equipped with a modem, you need a piece of software called a web browser to navigate the Web.

**Internet Explorer** and **Netscape** are examples of web browsers.

**Internet Service Providers**

To access the Internet, you need a **computer equipped with a modem and web browser**, but you'll also need an **ISP**.

**Internet Service Providers (ISPs)** are **companies** that provide access to the Internet.

For a monthly fee (and an initial activation fee), you can purchase a **software package** from your ISP. These packages feature different levels of Internet access. Flat-rate service will buy you unlimited hours, whereas a less-expensive hourly package buys limited Internet access. In either case, the speed with which you access the Internet factors into how much you pay per month.
The ISP software package usually includes:

- **Username.** A unique name used to gain access to a computer system.
- **Password.** A combination of keyboard characters. Used in combination with a username, passwords allow access to restricted computer information. It is important to keep passwords secret.
- **Access phone number.** For example, (919) 555-5555.

If you connect to the Internet at work, you may be part of a LAN (local area network) that shares network resources. To gain Internet access, your employer contracted with an ISP.

**The Need for Speed**

If you surf the Web frequently, you are probably used to waiting, and waiting, and waiting some more.

Slow Internet access means some users are unable to access certain web pages, especially those loaded with graphics, sound, and video. So, to access the latest web technologies, users need more speed.

In response to the need for speed, **modems (a device used to access the Internet)** were built that were capable of faster **data transmission rates.**

**Faster data transmission means:**

- Faster web pages
- Faster email services
- Music, animation, and video plays smoothly

**Data Transmission Rates**

At higher speeds, modems are measured in terms of **bits per second** (bps). A **bit** is a unit of measurement that measures the transfer of data, or information. For example, if you have a 56K modem, your modem may be capable of transferring 56,000 bits per second.

**Did You Know?** Eight bits of data is roughly the amount that you enter each time you tap a key on your keyboard.

**Data Transmission Rates:**

- **Early 90's**
  - 19.2K bits per second
  - 28.8K bits per second
  - 33.6K bits per second
• 1998-Present
  o 56K bits per second
  o Almost 10 Million bits per second (Asymmetric Digital Subscriber Line, (ADSL), Cable modems)

All About Bandwidth

A fast modem doesn't ensure fast transmission rates. Fast data transmission often depends on bandwidth.

Bandwidth is the amount of data actually being sent through a network circuit.

4. Browser Basics

If you found our web site, you're already familiar with your web browser's basic tools such as the Back button, Forward button and Address bar.

Here is a quick review of web browser basics:

• To return to the last page you viewed, click your Back button.
• To return to the page you visited before you clicked the Back button, click the Forward button.
• Click the drop down menu to the right of the back and forward buttons to view and select from a list of recently visited sites.
• To visit a web page, type the URL in the address bar and click the Go button or simply hit the Enter (Return) key on your keyboard.

```
```

Cache

➢ Have you ever started typing your favorite website's address, and the entire address displays?

| Address | www.gcf
|---------|---------|
| Favorites | http://www.gcflearnfree.org/courses/access2k/assignment1/page1.asp
| Favorites | http://www.gcflearnfree.org/courses/access2k/great_Lake_Elementary.mdb
| Favorites | http://www.gcflearnfree.org/courses/access2k/index.asp
| Favorites | http://www.gcflearnfree.org/courses/access2k/lesson10/page1.asp
| Fast 50 | http://www.gcflearnfree.org/courses/access2k/lesson10/page5.asp
| Fast 50 | http://www.gcflearnfree.org/courses/access2k/lesson12/page1.asp

➢ Or, have you tried clicking the address bar's drop down menu to display a list of sites you've recently visited?
What about the **Back and Forward** button's drop down lists of recently visited sites?

If you've used any of the methods listed above to surf the Web, you are using your web browser's **cache**.

Your web browser stores recently visited sites (as temporary Internet files) on your computer's hard disk. When you revisit your favorite sites, the browser **displays the pages from the cache instead of requesting them from the web server.**

✓ **This makes surfing the web faster and easier.**

### Refreshing and Stopping Web Pages

While using your browser's cache may increase ease of use, you may not be getting the most **up-to-date** information a site has to offer. To do so, you need to **refresh**, or **reload**, a web page. **Refreshing** requests fresh pages from the web server rather than from the cache stored on your machine's disk.

➢ Most browsers include a **Refresh button** on the toolbar. (F5)

**Refresh a web page when:**

- You want to view the latest version of the page. For example, when viewing a discussion forum, or a news-driven website.
- You get a message that a web page cannot be displayed. For example, "Error 404, File Not Found."

➢ Most browsers include a **Stop button** on the toolbar. (Esc)
Stop a web page when:

- You want to stop a web page from loading.
- A page is taking too long to load.
- You mistyped a URL.

**Search Engines**

Instead of trying to guess where certain information may be located on the Web, **search engines** allow you to search both the Web and newsgroups.

A **search engine** searches for **keywords** and returns a list of documents where the keywords can be found. Most search engines allow you to search using plain language relevant to the topic of interest, meaning you don't have to know any special programming tricks to effectively search the Web.

You're probably already familiar with search engines such as **Yahoo**, **Google**, **Excite**, or **AltaVista**.
There is tons of information available on the Web; you just have to know how to find it fast.

**Tips for Effective Searching**

- **Beware of using slang or partial words.** If you use slang or parts of words, you may have some luck, but your results may be too broad. For example, *flick* instead of *movie*, or *Macs* instead of *Macintoshes* may yield different results.

- **Correct Spelling, Pluralization and Capitalization.** Be aware of pluralizing your words, and spell them correctly. For example, *good will*, *goodwill*, *Goodwill*, *Goodwills*, and *Good Will* may yield different results.

- **AND.** Use AND (all caps) to search for multiple words that must appear in a web page. Some search engines support a plus sign (+) in place of AND. For example, *free AND coupon*, or *free + coupon*.

- **NOT.** Use NOT (all caps) to exclude certain words or phrases. For example, *casserole NOT chicken NOT beef.*
➤ **OR.** Use OR (all caps) to include any of the search words (rather than most.) For example, *George Washington OR Bush.*

➤ **Wildcards.** The percentage symbol (%) can be used to replace only one character. The asterisk (*) can be used to replace multiple characters. For example, *post* could produce **postwar, postgame,** or **postmarital.**

➤ **Phrases.** Put quotes around a phrase so each word in the phrase isn't searched for separately. For example, if you put quotes around "**free online computer training,**" the search engine searches for that **entire phrase** in a web page. However, if you simply type, **free online computer training,** the search engine searches for **each** of the words individually in a web page.

➤ **Get Help.** Go to your search engine's **Help page** for more specific information on a particular engine.

➤ **Try Something New.** There are many different search engines on the Web. If you can't find what you are looking for using your favorite engine, go somewhere else.

➤ **Bookmark it.** Add your favorite search engines to your Favorites to increase ease of use. If you're not sure how to do this, you'll learn how later in this unit.

- Open your web browser and review the web browser basics reviewed in this module.
- Open your cache and select a recently visited site.
- Refresh the page.
- Visit your favorite search engine.
- Open your search engine's Help file.
- Search for a new search engine. Sample its search capabilities.
- Using some of the searching tips, explore a topic of interest.

**Toolbars**

Internet Explorer features customizable **toolbars** to help you navigate the Web. Below are the toolbars featured in IE 5.

➤ The **Standard buttons bar** displays commonly used buttons such as the Back, Forward, Stop, Refresh, Home, Search, Favorites, History, and Print buttons.

[Standard button bar (shown with large icons and text labels) displaying some commonly used buttons.]

➤ The **Address bar** displays the address, or URL, of the web page you are currently visiting. Type new URLs or search terms into the Address bar.
The **Links bar** is a convenient place to add frequently used links.

![Links bar](image)

The **Radio bar**, available when Windows Media Player is installed, includes a radio station guide and control button such as "play" and "volume."

![Radio bar](image)

**Status bar and Explorer bar**

Internet Explorer's **Status bar and Explorer bar** offer additional web navigation methods.

- The **Status bar**, located at the bottom of the IE window, indicates when a web site is found, loading, waiting for reply, or if you have a secure connection. It is always a good idea to display the Status bar, particularly for security reasons discussed in Unit 4.

![Status bar](image)

- The **Explorer bar** is a sidebar located in the left side of the IE window. It's a convenient way of accessing the Favorites list, History list, and Search function.
Click Next to learn how to show and hide the toolbars, Status bar, and Explorer bar.

Show and Hide Toolbars, Status bar and Explorer bar

In newer versions of Internet Explorer, you can show and hide the toolbars, Status bar and Explorer bar.

To show or hide the toolbars:

- Choose View → Toolbars from the IE menu bar.
- Click the clear or show the checkmark for each item.
OR

- **Right-click** the toolbar and click to clear or show the **checkmark** for each item.

To show or hide the Status bar:

- Choose View → and click to clear or show the **checkmark**.

To show or hide the Explorer bar:

- Choose View → Explorer bar.
- Choose from Search, Favorites, History, or Folders.

OR

- Click on the **Standard button toolbar**.
- Click button again to hide the Explorer bar or click the X in the upper right corner or the Explorer bar.

**Customizing Toolbars**

In newer versions of Internet Explorer, you can **move** and **resize** the **toolbars**.
To move a toolbar:

- Look for the resize/move toolbar handle.
- **Hover your mouse pointer** over the resize/move toolbar handle. The mouse pointer becomes a **double-headed arrow**.
- **Click and drag** a toolbar up, down, left, or right. When moved, toolbars "snap" to the outer edge of the IE window.

To resize a toolbar:

- Look for the resize/move toolbar handle. **Hover your mouse pointer** over the resize/move toolbar handle. The mouse pointer becomes a **double-headed arrow**.
- **Click and drag** until toolbar is **desired size**.

![Resize/move toolbar handle](image)

Mouse pointer becomes double-headed arrow

**Customizing the Standard Button Bar:**

You can further customize the **Standard button toolbar** by adding or removing **Standard buttons**. You can even **change the appearance** of your buttons.

Add or remove a button from the Standard button bar:

- Choose **View → Toolbars → Customize** from the IE menu bar.

OR

- **Right-click** the toolbar and click **Customize**.

  - The **Customize Toolbar** dialog box opens.
  - In the left-hand scroll box, there is a list of **Available toolbar buttons**.
  - In the right-hand scroll box, there is a list of **Current toolbar buttons**.
  - In either scroll box, **click to select a button** you would like to **add or remove**.
  - Click the **Add** or **Remove** button.
  - The button is now added or removed from the toolbar.
  - Click **Close** to display new options.
To change the text options featured on your buttons:

- With the Customize Toolbar dialog box open, click the Text Options drop down box to select No text labels, Show text labels, and Selective text on right.
- Click Close to display new options.

To change the size of your button icons:

- With the Customize Toolbar dialog box open, click the Icon Options drop down box to select Small icons or Large icons.
- Click Close to display new options.

Setting a Home page

Your home page is the first page you see when you start Internet Explorer (IE). Change your home page to make surfing the Web easier and more convenient.

For example, if you want to start each Internet session with GCF Global Learning, http://www.gcflearnfree.org should be your home page. If you like to check the weather every time you log on, you might prefer http://www.weather.com as your home page.

To change the Home Page:

- Choose Tools → Internet Options from the IE menu bar. The Internet Options dialog box opens.
- If not already selected, click the **General** tab.
- **Type a new URL** in the home page section of the **General** tab.
- Click **OK**.

OR

- If you like the current page and want to set it as your new home page, click the **Use Current** button.
- The **Use Default** button sets **www.microsoft.com** as your home page.
- The **Use Blank** button sets a blank page as your home page. This option is beneficial to those who don't want to begin each Internet session waiting for a home page to load.
- Click **OK**.
20

Anatomy of an Email Address

An email address is required to send and receive email. Email addresses are different from "snail mail" addresses. They usually consist of three parts: a user name, an "at" symbol (@), and a domain name.

jdoe@gcflearnfree.org

1. **User name**: jdoe
   Located to the left of the @ symbol, a user name identifies your account on the email server that handles the email. For example, John Doe might choose "jdoe" as his username. However, someone may have already chosen jdoe, so have some other choices ready. Choose a user name that sounds professional and is easy to remember.

2. **@**
   Means "at" and separates your account name and the name of the mail server name. For example, jdoe "is located at" gcflearnfree.org.

3. **Domain Name**: gcflearnfree.org
   The domain name usually consists of two pieces of identifying information. The
first piece is the name of the **email server** and is located to the **right** of the @ symbol. For example, `gcflearnfree` is the name of the email server. The **second piece**, usually a three-letter **extension**, indicates the **top-level domain**. They are separated by **periods**, called "dots."

✔ Consider choosing a user name that protects your identity instead of your first and/or last name.
**Top Level Domains**

**Top-level domains** may help you figure out the type of organization the recipient is associated with. See the chart below.

<table>
<thead>
<tr>
<th>Extension</th>
<th>Meaning</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>.org</td>
<td>A non-profit or not-for-profit institution</td>
<td><a href="http://www.GCFLearnFree.org">www.GCFLearnFree.org</a>, <a href="http://www.goodwillnc.org">www.goodwillnc.org</a></td>
</tr>
<tr>
<td>.mil</td>
<td>US Military</td>
<td><a href="http://www.army.mil">www.army.mil</a>, navy.mil</td>
</tr>
<tr>
<td>.edu</td>
<td>US Educational institution</td>
<td><a href="http://www.ncsu.edu">www.ncsu.edu</a>, <a href="http://www.duke.edu">www.duke.edu</a>,</td>
</tr>
<tr>
<td>.net</td>
<td>ISP or Network Provider</td>
<td><a href="http://www.earthlink.net">www.earthlink.net</a></td>
</tr>
</tbody>
</table>

✔ If there is a two-letter extension, it is usually a country code. For example, Malaysia uses "my."

✔ Because not everyone uses top-level domains correctly, they are not always a reliable way to determine an organization's association.

**Email Clients**

To send and receive email, both the sender and recipient must have the right tools: an Internet connection, an email client, and an email address.

An **email client** (sometimes referred to as a **composer**) is **software** that runs on a personal computer, and relies on an Internet connection to perform some of its operations.

Email clients work with any **ISP** (Internet Service Provider) that uses standard Internet email **protocols**. These protocols make it possible for people using different email client software to communicate with one another. For example, if I use **Microsoft OutlookTM**, I can send and receive email with someone who uses **QUALCOMM EudoraTM**.

**To set up your email client correctly, you need:**
- POP3 (Post Office Protocol, version 3) server address
• SMTP (Standard Mail Transfer Protocol) server address

✓ Your Internet service provider gives you this information.

✓ Free web mail accounts, such as Hotmail or Yahoo, rely on an Internet connection and use an email client that appears in a web page. Additional email client software is not required.

Email Clients are Different

Most email client software allows you to:

• Display a list of received messages. Each message header shows you who sent the mail, the subject line, the time and date it was sent, and at times, the size of the message.
• Select the message header and read the message.
• Create new messages.
• Reply to, forward, and delete messages.
• "Attach" files (called attachments) to messages you send.
• Save the attachments you receive.

Some email clients offer:

• Address book/Contacts: Use the electronic address book to track personal information such as name, title, email addresses, home and work addresses, phone numbers, and much more.

• Newsgroup functionality: You can use your email client to access Usenet, an online public bulletin board system (BBS). Usenet features a broad range of discussion topics called newsgroups.

• Calendaring: Schedule important dates, appointments, tasks, and electronic reminders.

The Email Message Window -- Sending a New Message

Use the email message window to compose and send email messages.

To send a new message:

• Once you’ve opened your email client’s window, click the New Mail or Compose button.
• The email message window appears.
- Look for a **menu bar** and **toolbar** to help compose and format your message.
- Below the menu bar and toolbar, there are several **fields**. These fields may include **To**, **CC**, **BCC**, **Subject**, and the **message body area**.

![Image of email message window with menu bar, toolbar, and fields]

 Covenant

> ![Image of email message window with menu bar, toolbar, and fields]

✓ Click Next to learn more about completing the email message window.

**To and From**

In the email message window, type the **recipient's email address** in the **To**: field. This tells the email server where to send the email message.

![Image of email message window with To field filled]

- The person who is composing the email is called a **sender**. When the **recipient** receives a message, a **message header** (sender's email information, subject line, and time received, usually) appears in the recipients INBOX.
Carbon Copy (CC) and Blind Carbon Copy (BCC)

CC: (short for Carbon Copy) and BCC: (short for Blind Carbon Copy) are additional fields used to send multiple copies of a message.

To send copies of your message:
- You can type multiple email addresses into the To: field.

OR

- Type additional email addresses into the CC: field.
- Typing additional email addresses into the BCC: field allows you to send a copy to someone else without the main recipient knowing you have done so. The BCC: recipient sees the main message and all intended recipients.

In any case, separate email addresses with a comma or semicolon.

The Subject Line and Body of the Message

When sending an email, the sender has the option to write a subject line. When the recipient checks their email, the subject line appears in the message header. Make sure your subject line describes the topic of your email message. A well-written subject line helps recipients prioritize their email responses.
The **body** of the email message is typed directly into the large blank space (message area). Most email clients support cut, copy, and paste functions, so you don't need to retype information needlessly.

Send and Receive

Now that you can compose a new email message, you'll want to **send** your message. That's easy; just click the **Send** button.

To **receive** new messages (known as "checking your email"), you may need to click the **Send and Receive** button to display new email. To automate this process, some email clients let you set up a **schedule**. Others display a **graphical or audio notice**.

What is an Attachment?

Email is one of the quickest ways of sharing information with others. Learning to create, send, and open an **email attachment** is the next step to becoming an email pro.
Using your email client's attachment feature, you can attach and send different file types along with your email messages. When sending an email attachment, your email program changes (encodes) your file so it can be sent across the Internet.

To send an email attachment:

- Enter a message into an email message window.
- Click the Attachment button.
- A dialog box opens (depends on email client). Browse until you locate the file you want to attach.
- Select the file.
- Click OK or Insert or Choose (depends on email client).
- The dialog box closes. Look for the file icon or name in your email client's attachment area. The file should be attached.
- Click Send. You might get a message such as, "Encoding Attachment," meaning the attachment is being sent.
Attach with Care

When sending email attachments, keep the following in mind:

1. **Be aware of the programs your intended recipient uses.** In order to open an attachment, you must have a program that can open that file type. If you are both using the same operating system, the same word-processing program, and a newer or commonly used email client, you shouldn't have any problems.

2. **Include a note that briefly describes the attached file.** This alerts the recipient that an attachment is included. For example, "Attached is the third quarter schedule. It is a Microsoft Word XP document."

3. **The file name should describe the attachment.** This, along with your note that describes the attached file, is common courtesy. Your recipient will feel more comfortable opening the attachment.

4. **If necessary, choose Text-Only.** Although some newer word processing programs are able to open other word processors' files, some information and formatting can be lost in translation. For example, if you created a document using Microsoft Word and you know your intended recipients use Claris Works, they aren't going to be able to read your document. Save yourself a headache and send the document as text-only.

5. **If necessary, choose RTF (rich text formatted).** RTF is a standard file format almost all word-processors can read. RTF includes basic formatting information, such as changes in font, font size, and font style.

6. **Double-check it.** Make sure you have actually attached the file before you click Send. It's embarrassing to have to resend the message.
Most word processors have a Save as option that allows you to save your file in a variety of different formats, including RTF.

6. Summary

(a) Describe how the internet works and its major capabilities.

The Internet is a worldwide network of networks that uses the client/server model of computing and the TCP/IP network reference model. Using the INTERNET, any computer can communicate with any other computer connected to the INTERNET throughout the world. The Internet has no central management. The Internet is used for communications, including e-mail, public forums on thousands of topics, and live, interactive conversations. It is also used for information retrieval from hundreds of libraries and thousands of library, corporate, government, and nonprofit databases. It has developed into an effective way for individuals and organizations to offer information and products through a web of graphical user interfaces and easy-to-use links worldwide. Major Internet capabilities include e-mail, USENET, LISTSERV, Chatting, Telnet, FTP, Gophers, Archie, Veronica, WAIS, and the World Wide Web.

(b) Identify the benefits the internet offers organizations

Many organizations use the INTERNET to reduce communications costs when they coordinate organizational activities and communicate with employees. Researchers and knowledge workers are finding the Internet a quick, low-cost way to gather and disperse knowledge. The global connectivity and low cost of the internet helps organizations lower transaction and agency costs, allowing them to link directly to suppliers, customers, and business partners and to coordinate activities on a global scale with limited resources and closer relationships with customers. Communication can be customized to specific audiences.

(c) Examine the challenges posed by the Internet to business and Society.

Use of the Internet for electronic commerce and electronic business is in infancy in Nigeria. Some of the new business models based on the Internet have not yet found proven ways to generate profits or reduce costs. Organizational change, including redesign of business processes and new roles for employees is often required; channel conflicts may erupt as the firm turns to the internet as alternative outlets for sales, security, privacy, legal issues, network reliability, bandwidth, and integration of Internet-based applications with the firm’s legacy systems pose additional challenges to internet computing.

Finally, the Internet is a veritable tool for learning and for business.
References/internet Resources